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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Referto the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

e The M-Duino Family PLCs are Open Type Controllers. It is required that you install the
M-Duino PLC in a housing, cabinet, or electric control room. Entry to the housing,
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cabinet, or electric control room should be limited to authorized personnel. Failure to
follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when installing M-Duino family
PLCs.

e In case of installation or maintenance of the M-Duino please follow the instructions
marked in the Installation and Maintenance section.

e Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

e Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contrdleur.

e Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.

e Reportez-vous au Guide de I'utilisateur du contréleur pour les considérations de
cablage.

e Avant d'utiliser ce produit, il incombe a I'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui I'accompagne.

e La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

e La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

e Faites attention lors de I'entretien des composants sensibles a I'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

e Les automates de la famille M-Duino sont des contréleurs de type ouvert. Il est
nécessaire d'installer |'automate M-Duino dans un boftier, une armoire ou une salle de
controdle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de I'installation des automates de la
famille M-Duino.

e En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

e Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

¢ Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.
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Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.
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Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: - Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification — Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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ETL Listing Mark-Direct Imprint information

RECOGNIZED
COMPONENT
o™ Conforms to UL Std. 61010-1
Conforms to UL Std. 61010-2-201
C us Certified to CSA Std. C22.2 No. 61010-1
LiSTED Certified to CSA Std. C22.2 No. 61010-2-201
Intertek
5016476
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INDUSTRIAL SHIELDS

1 General Description M-DUINO 21 I/0s PLUS product

1.1  Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is
important to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the
shield from below and B the shield from above. It has 2 zones (A, B):

e The inputs in the zone B are named 10.X, being X any number suitable in the
Shield. Outputs are named as QO0.X.

. y R

A

—
'd

[ 1g
A

A ZONE
B ZONE
B ZONE
A ZONE

X el | BZONE
{ w2’ AZONE

12
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1.2 Zone Distribution

ZONEA |—*=| ZONEB

Communication

J
Digital

Y

The distribution of the different features that provide the M-Duino 21 1/0Os PLUS is the
following one:

Shield B Zone

13 Inputs
(13 Digital inputs,
6 of which can
work as Analog
Input)
Analog Shield

8 Outputs
(8 Digital Outputs,
3 of which can
work as Analog
Output)

13
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1.3 A Zone Features

Shield

A Zone

Communication

Shield

(1x) Ethernet

(1x) USB

(1x) 12C

(3x) TTL

(1x) RS-232

(1x) HALF/FULL Duplex RS-485
(1x) SPI external Port

(1x) RTC

(1x) uSD Socket

1.4  Mechanical dimension

L

Rev. 2: 12-01-2022
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1.5 General Features

Rev. 2: 12-01-2022

CONECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE A+B Zone
Fuse protection (2.5A)
Input Voltage 12:072_4\/“ Polarity protection
24 Vd
Input rated voltage =C
Rated Power 30W
| max. 1.5A
Size 101x70.1x119.5
Clock Speed 16MHz
Flash Memory 256KB of which 8KB used by bootloader
SRAM 8KB
EEPROM 4KB

Communications

12C — Ethernet Port — USB — RS485 — RS232 -- SPI

— (2x) Rx, Tx (Arduino pins)

Max232-Max485-W5500

USB consideration!

Only meant for uploading or debugging, not

always connected as a serial in a project!

Cannot be working in afinal
application

An/Dig Input 10Dbit
(0-10Vcce)

0 to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac

7 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

Digital Isolated Input
(24Vcce)

7 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

* Interrupt isolated
Input HS (24vcce)

7 to 24Vdc
I min: 2to 12 mA
Galvanic Isolation
Rated Voltage: 24Vdc

Analog Output 8bit
(0-10Vcce)

0 to 10Vac
I max: 20 mA
Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated
Output (24vcce)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

Digital Isolated
Output Relay

220V Vdc
I max: 5A
Galvanic Isolation
Diode protected for Relay

15
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5 to 24Vdc
I max: 70 mA
PWM Isolated Output Galvanic Isolation
. Diode Protected for Relay
8bit (24vce) Rated Voltage: 24Vdc
Expandability 12C - 127 elements - Serial Port RS232/RS485
* By using this type of signal can no longer use Digital signal
(24vdc)

16
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2 Technical Specifications:

2.1  General Specifications:

Item

M-Duino PLC Arduino Ethernet 21 I1/Os Analog/Digital PLUS

Power supply

voltage DC power supply

12 to 24Vvdc _—=

Operating

voltage range DC power supply

11.4t025.4Vdc ===

Power
consumption DC power supply 30W max.
Power supply 2avde ===
External voltage
power supply Power supply 700Ma

output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the
external AC terminals and the protective ground terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 378g max.

2.2 Performance Specification:

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programming language. “similar to the C”. http://arduino.cc/en/Tutoria/HomePage

Microcontroller

ATmega2560

Flash Memory

256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB
EEPROM 4KB

Clock Speed 16MHz

Clock Speed 16MHz

17
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2.3 Symbology
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Table that includes all the symbology that is used in the serigraph of the M-Duino PLC Arduino

Ethernet 21

I/Os Analog/Digital PLUS:

Symbol Standard No. / Standard Symbol Meaning
Standard Title Reference No. /
Symbol Title
IEC 60417 / 5031 / Direct Indicates that the equipment is
] Graphical symbols Current suitable for direct current only;
HE BN =Em for use on to identify relevant terminals
equipment
IEC 60417/ 5032 / Alternating | Indicates that the equipment is
Graphical symbols Current suitable for alternating current
for use on only; to identify relevant
N equipment terminals
IEC 60417 / 5130/ Pulse To identify the control by
Graphical symbols General which a pulse is started.
for use on
equipment
IEC 60417 / 5017 / Earth, To identify an earth (ground)
Graphical symbols Ground terminal in cases where
for use on neither the symbol 5018 nor
p— equipment 5019 is explicily required.
IEC 60417/ 5115/ Slgnal lamp To identify the switch by
Graphical symbols means of which the signal
for use on lamp(s) is (are) switched on or
equipment off.
2004/108/EC / CE Marking CE marking indicates that a
Electromagnetic product complies with
Compatibility applicable European Union
regulations
ISO 7000/ 0434B/ Indicates a potentially
Graphical symbols | Warning symbol hazardous situation which, if
for use on not avoided, could result in
equipment death or serious injury
ISO 7000/ 5036 / Dangerous To indicate hazards arising
Graphical symbols Voltage from dangerous voltages
for use on
equipment

18
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3 Precautions

Read this manual before attempting to use the M-Duino PLC Arduino Ethernet 21 1/Os
Analog/Digital PLUS and follow its descriptions for reference during operation.

3.1 Arduino Board

The M-Duino 21 1/Os PLUS PLCs include Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate M-Duino according to the performance specifications described in this
manual.

Before using M-Duino under different conditions from what has been specified in this manual
or integrating M-Duino to nuclear control systems, railroad systems, aviation systems, vehicles,
combustion systems, medical equipment, amusement machines, safety equipment and other
systems, machines, and equipment that may have a serious influence on lives and property if
used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and
performance characteristics of M-Duino are sufficient for the systems, machines, and
equipment, and be sure to provide the systems, machines, and equipment double safety
mechanisms. This manual provides information for programming and operating the M-Duino.

4 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically it is no
needed to define the pins and if that pins are inputs or outputs. Everything is set up
automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).

19
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Steps:
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1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences

Settings | Network:
Sketchbook: location
C:\Users\Albert\Documents!Arduino
Editor language: English (English)

Editor font size: 15

Interface scale: Auﬂmﬂat\c 100 % %%

Show verbose output during: ompilation upload

Compiler warnings: None v
[Jpisplay line numbers

[Jenable code Folding

[] verify code after upload

[ use external editor

Check for updates on startup

Save when verifying or uploading

Update sketch files to new extension on save (pde - .ino)

Browse

~| (requires restart of Arduino)

(requires restart of Arduina)

Additional Boards Manager URLs: | http://apps. industr ialshields.com/main/arduino/boards/package_industrialshields_inde: [

an be edite ectly in the file

More prefer
C:\Users\Albert\appDataiLocal\Arduino 15\preferences, tet

oK Cancel

2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board: ... -> Boards Manager

© skewch_mar16a | Arduing 180

File Ecit Sketch Tools Help

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Senal Plotter

WFi101 Finmware Updater
Board: "M-Duino family”
Inchusirial Shielcls: "M-Duino 58+
Port

Get Board Info

Programmer: “Ardhino as ISP’
Burn Bootioader

- _
M

Boards Manager...
uino AVR Boards
Arduine Yiin
Ascluino/Genwino Una
Arduino Duemilanove or Diecimila
Arduine Hano
Asduino/ Genano Mega of Mega 2560
Arduing Mega ADK
Arduino Leonardo
Arduino Leonardo ETH
Arduino/Genwino Micro
Ascluino Esplora
Arduino Min
Arduino Ethernet
Ardhino Fio
Arcuino BT
LilyPad Arduno US8
LilyPad Archino
Archuing Pro of Pro Mim
Aschuine WG or older
Arduin Robot Control
Arduino Robot Motor
Arduino Gemma
Adalruit Circuit Payground
Arduino Yun Mini
Arduine Incustrial 101
Linino One
Arduing Uno Wit
Indusinal Shiekds boards
Ardbox family
# M-Duino family

20
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5. Search for “industrialshields” on the browser.

€ Boards Manager X
Type All ~ | lindustrialshields
industrialshields ~
Boards included in this package:
ARDBOX family, M-Duino family.
Online help
More info
Install
v
Close
6. Click install (selecting the latest version).
Following these steps you will be able to see now the Industrial Shields Boards:

@ ESP32AccessPoint | Arduing 189
File Edit Sketch Tools Help

Auto Format ansT
Archive Sketch
Fix Encoding & Reload

Manage Libraries. CurlShift+] ~
Serial Monitor Curl=Shitt+M
Serial Plotter Cri=Shift+L

WIFI101 / WIFININA Firmware Updater

Board: “M-Duino family” i Boaras Manager
Madel: *M-Duing 19R+' 3 .
o MS5tack-FIRE

Get Board Info MSStick-C

ODROID ESP32
Heltec WiFi Kit 32
Heltec WiFi LoRa 32
Heftec WiFi LoRa 32042)
Heltec Wireless Stick.
ESPectro32
Microduino-CoreESP32
ALKS ESP32
WiPy 30
BPI-BIT
Silicognition wESP32
T-Beam
D-duina-32
2 LaPy
cintt: LoPy4
OROCA EduBiot
ESP32 FM Devit
Frog Board ESP32
Al Thinker ESP32-CAM
Sparkfun LoRa Gateway 1-Channel

Pragrammer: “Arduing Gemma®
Bum Bootioader

WiFi madule

"Ardbax GPRS family
Ardbox WiFI/BT tamily
M-Duino family

M-Duino GPRS family

QGUViF/BT fami
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Once it is selected M-Duino Family, an extra option will appear on Tools:

There, it can be selected the exact model for every family.

@ ESP32AccessPoint | Arduing 189 - o *
File Edit Sketch Tools Help

Auto Format

T
Archive Sketch
§  FixEncoding & Reload

Manage Libraries._. CtrleShifts]
Serial Monitor Carl=Shift+M
Serial Plotter Curl=Shift+L

WIFIT01 / WIFININA Firmware Updater

Board: “M-Duino family
Maodel. “M-Duino 21+° i M-Duina 19R
t M-Duino 19R+
Get Board Info M-Duing 21
®  M-Duino 21+
7 M-Duino 38AR-
M-Duin 38R
M-Duing 38R+

Pragrammer: “Arduing Gemma~
Bum Boatioader

M-Duino 42
M-Duino 42+
M-Duino SORRA+
M-Duing 53ARR+

ESP32 code M-Duing S4ARA+
o M-Duino STAAR +
7i-Fi library M-Duino STR
ie <WiFi.h> M-Duina 57R+
M-Duino 58

M-Duino 58+

hart passward

server(80);

header;

Also there are some examples of programming in File -> Examples -> M-Duino Family.

Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/

5 How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
M-Duino 21 1/Os PLUS uses USB-B cable.

- Open Arduino IDE interface:

- Select Industrial Shields boards -> M-Duino Family
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- Select the correct M-Duino Board (M-Duino 21+).

P32AccessPoint | Arduino 189 - o *

File Edit Sketch Tools Help

Auto Format ansT
Archive Sketch

Fix Encoding & Reload

Manage Libraries. CurlShift+] ~
Serial Monitor Ctrl+Shift+M
Serial Plotter Cri=Shift+L

WIFI101 / WIFININA Firmware Updater

Board: “M-Duino family
Maodel. “M-Duino 21+°

M-Duino 198+
M-Duina 21
M-Duino 21+

M-Duino 38AR +
M-Duina 38R

Get Board Info

Pragrammer: “Arduing Gemma~
Bum Boatioader

M-Duino 42
M-Duino 42+
M-Duino SORRA+
M-Duing 53ARR+
M-Duing S4ARA+
M-Duino STAAR +
M-Duina 57R
M-Duino 57R
M-Duino 58
M-Duino 58+

- Select correct port.

@ sketch mar16a | Arduino 130 - 8 x
File Eit Sketch Tools Help
Autn Format culeT
Auchive Sketch
shetch marls Fix Encading & Reload
Serial Monitor CufeShittah =
Senial Plotter Cul+ShiftsL

VAR 101 Finmware Updater

Boardt “Arcbon lamily™ >
Industrial Shields: “Ardiox Analog™ >
Fort i il ports

PUT ¥ GetBowd info COMI3 (Ardhino Leonarde)
Programmer: “Archano as ISP )

Bun Boodoader
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6 How to connect PLC to power supply

- M-Duino 21 1/0s PLUS PLC is 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

[——
u GND I

|—1I 24Voe |

| I

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm

DIN Rail: g
-12vdc / 24Vdc =

-2.5A

-30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent

TR RE

protection. There is a LED inductor for power status,
the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-
1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.
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7 M-Duino 21 I/0s PLUS Pinout

7.1 A Zone connection

e

Base

(common unit)

A Zone
5 £
=t o
28] ¢ 5
S C 5 S
25| € 5
=0 < [y
SCL 21 12C/SS
SDA 20 12C/SS
RX0 1 RX0/SS
TXO0 0 TXO0/SS
RX1 19 RX1/SS
TX1 18 TX1/SS
> 16 RX2(serial 2)
RX 17 TX2(serial 2)
Z- - RS485
Y+ - RS485
B- - RS485
A+ - RS485
PIN3 3 Arduino Pin
50 SO 50 SPI
51 Sl 51 SPI
52 SCK 52 SPI
Reset | Reset SPI
Vin5 Vin5 5V
PIN2 2 Arduino Pin
GND - Gnd
GND - Gnd
24Vdc Power Supply

Base

(common unit)

A Zone

onnector
duino P

Function

AREF AREF  |Arduino PIN
IOREF2 | IOREF2 [(Arduino PIN
IOREF1 | IOREF1 |Arduino PIN

7vdc 7Vdc -
GND GND GND
3.3vdc | 3.3vdc |Arduino PIN
GND GND GND
5vdc 5Vdc -
GND GND GND

ARef
sQw
IORef
3.3vdc
5vdc
Gnd

1
@
S

Configuration Switch* (see section 8 for
configuring the communications.
Enabling communications disables some
1/0s)

Communication Pins

Power supply connectors

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any device.

=

[]

]

OFF

ON

Rxl/ 1

SCL/12.6
SDA/I25
6
Tx1/11.5

Pin3/106
Pin2/105
D53(SD)
FD rsass HD

ON
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é 8
. %g z3 W
L] on I
- 4 <Ez\J P "
B i2 CE g e
§ < _Reser [ usB B Frogam | @ K2
E5 RTC Banery (CB#D) *uSD Socket[J
Ethernet Arduino / Power
Connector Reset button

USB programmer
connector

Autoreset

*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using
serial communication. When uploading code to Arduino Mega set switch to ON.
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7.2 B Zone (Analog Shield)
N
B Zone
- c —ofTjo—
o o o Analog:
=] o c 0-10vde
3¢ | & 2 v
=5 | 2 g L
O < E Eﬁgﬁal:
5 - 24Vdc
10.12 59 Analog/ Digital In o
10.11 58 Analog/ Digital In
10.10 57 Analog/ Digital In i
10.9 56 Analog/ Digital In 1010 —efT
10.8 55 Analog/ Digital In 0 ﬁj
10.7 54 Analog/ Digital In : (Lo
()I0.6INTL | - GND 10.6 07 T
10.6/INT1% 3 Interrupt 1 In 10.6/INT 1=
(-)10.5/INTO - GND 10.5 ()10 S/NTD
10.5/INTO 2 Interrupt 0 In 10-5/INTO
(-)lo.4 - GND 10.4 (-)10.4—
10.4 26 Digital Input 04 -7
()03 - GND 10.3 QI3
10.3 25 DIgIta' Input (-)102—
()10.2 5 GND 10.2 02 -
10.2 24 Digital Input Q01—
(-)I0.1 - GND 10.1 ()10, 0
10.1 23 Digital Input 100 o
(-)10.0 5 GND 10.0
10.0 22 Digital Input
Top Zone

(@] KX

Led indicator 1/Os state

B Zone

e5s c

S5 | ¢ 5

ac e I3]

=5 3 s

o
o = T
<

GND GND GND
A0.7* 6 Analog Out
A0.6* 5 Analog Out
A0.5! 4 Analog Out
Q/Vdc - External Isolated Out Vdc
COM(-) - External Isolated Out GND
QO0.7* 6 Digital/PWM Out
QO0.6! 5 Digital/PWM Out
Q0.5 4 Digital/PWM Out
Q0.4 40 Digital Out
Q0.3 39 Digital Out
Q0.2 38 Digital Out
Q0.1 37 Digital Out
Q0.0 36 Digital Out

OM: DIGITAL
OFF: ANALOG

C§ Digital/PWM

Q/vde

GND
3 |A07
3 |A06

AD.5
a/vde
COM(-)

@nQo.7

EMNa0.6

Q0.5

Qo4

Qo3

Qo2

Qo.1

®- Q0o

* Note: use correctly configuration for

use this signal
(see user guide)

Rev. 2: 12-01-2022

Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isolated)

Configuration Switch*
(see section 8 to select the correct
configuration for outputs).

Analog Outputs

Voltage Supply/Reference for
Digital/PWM Outputs (isolated)

PWM/Digital Outputs

1 See section 8 to select suitable switch configuration for enable these connections.
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8 Switch Configuration

8.1 A Zone: Communications

Switch
ON OFF
D ZONE
SCL/12.6 NC scL
SDA/I2.5 NC SDA
C ZONE
RX1/11.6 NC RX1
TX1/11.5 NC TX1
B ZONE
Pin 3/10.6 10.6 Pin 3
Pin 2/10.5 10.5 Pin 2
uSD & RS-485
D53(SD) NC SD
FD RS-485 HD HD FD
OFF oM
SCL/ NC
SDA / NC
Rx1/ NC
' Tx1/ NC
[ ]
PiN3 /106
Pin2 /10.5
D53(SD)
FD RS485 HD

OFF on

4. SCL/NC: Always at OFF Position! Switch has to be OFF position to enable SCL, never ON
because in this position is NC (Not Connected).

3. SDA/NC: Always at OFF Position! Switch has to be OFF position to enable SDA, never ON
because in this position is NC (Not Connected).

2. RX1/NC: Always at OFF Position! Switch has to be OFF position to enable RX1 never ON
because in this position is NC (Not Connected).

1. TX1/NC: Always at OFF Position! Switch has to be OFF position to enable TX1, never ON
because in this position is NC (Not Connected).
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4. Pin 3/10.6: Choosing between Pin 3 or the input 10.6. If this switch is ON, it enables the 10.6
input and disables the Pin 3. If this switch is OFF, it enables Pin 3 and disables 10.6.

3. Pin 2/10.5: Choosing between Pin 2 or the input 10.5. If this switch is ON, it enables the 10.5
input and disables the Pin 2. If this switch is OFF, it enables Pin 2 and disables 10.5.

2. D53 (SD): Always at OFF Position! Switch has to be OFF position to enable the Chip Select of
the microSD card, never ON because in this position is NC (Not Connected).

1. FD RS-485 HD: Choosing between FD or HF. If this switch is ON, it enables the Half Duplex
(HD) option and disables the FD. If this switch is OFF, it enables Full Duplex (FD) and disables
HD.

ore on
LEFT ZONE
SWITCH ON OFF
NC - -
NG - - RTC SCL
RTC SCL RTC - RTC SODA |
RTC SDA RTC - Se

1. RTCSDA: This switch enables the communication to communicate with the RTC using
12C. Having this switch in ON mode it actives this communication, whereas if it is in
OFF mode it disables the 12C to reach the RTC.

2. RTC SCL: This switch enables the communication to communicate with the RTC using
12C. Having this switch in ON mode it actives this communication, whereas if it is in

OFF mode it disables the 12C to reach the RTC.

3. NC: Not connected. This switch is not connected to anything, it doesn’t matter if it is in
ON mode or OFF mode.

4. NC: Not connected. This switch is not connected to anything, it doesn’t matter if it is in
ON mode or OFF mode.
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8.2 B, C&D Zone Swithces

B ZONE CZONE D ZONE
SWITCH ON | OFF SWITCH ON | OFF SWITCH ON | OFF
NC - - NC - - NC - -
Q0.7 Q0.7 | A0.7 Q1.7 Ql.7 | A1.7 Q2.7 - -
Q0.6 Q0.6 | A0.6 Q1.6 Ql.6 | Al1.6 Q2.6 Q2.6 | A2.6
Q0.5 Q0.5 | A0.5 Q1.5 Q1.5 | A15 Q2.5 Q2.5 | A2.5

Q17
Q16
Q15

ON: DIGITAL
OFF. ANALOG

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF
it can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide
this analog output is represented with AX.X, being X any number of the tables above.

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it
can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide
this analog output is represented with AX.X, being X any number of the tables above.
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9 M-Duino Arduino I/Os 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present
in the pins (for example 12C communication in pins SCL and SDA). As this pins are directly
connected to the Arduino Mega board they are not as well protect as the normal inputs. These
pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarized in the table below. In order to access some
of these pins the configuration switch must be set to OFF position (see section 8) and some
extra considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TXO0 1
RX1 19 Communication switch: OFF
TX1 18 Communication switch: OFF
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Mega board.

A part from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

9.1 12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case
it reads 5V when nothing is connected. The pull-up configuration is stablished by default in
these pins.

If it is meant to work them as a GPIO at 5V, it has to be considered that they are pull-up
inputs.

*IMPORTANT: 12.5 & 12.6 are not pull-up inputs although they are referred to the 12C pins
(switch configuration). There is a “reverse pull-up circuit “that is stablished in order to have the
same behaviour as the other inputs.

9.2  Serial 0 - RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared
with the USB interface. If using these pins, the USB communication cannot be working at the
same time. When the PLC is not installed, the USB communication is normally required for
debugging, uploading and intercommunicating with the Ethernet controller. If using both
interfaces at the same time the Arduino board will get blocked.
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These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.3 Serial 1 - RX1/TX1

These pins are only referred to the inputs 11.5/11.6. If the switch configuration is in OFF
position the pins RX1/TX1 will be available. If not using the Serial 1 interface these pins can
work as digital, either input or output.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.4  SPI- MISO/MOSI/SCK

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.5 Pin2/Pin3

These pins are only referred to the inputs 10.5/10.6. If the switch configuration is in OFF
position the pins Pin 2/Pin 3 will be available.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.
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10 A Zone Features: Communications & RTC & uSD

10.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.

10.2 RS-485
For RS485 communication protocol the defined Arduino Mega pins are showed in the chart
below.
Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects in this
communication. The RS-485 protocol will be always enabled, the only switch that affects is the
one called “FD rs-485 HD” (See Section 8). This switch makes the choosing between RS-485
Half Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

10.3 I2C

12C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino 21 1/Os PLUS. The
pull-up resistor is already implemented in the PCB.

12C communication is configured by switches, so the switches must be configured in order to
enable the 12C communication.

Switch | ON OFF
D ZONE

SCL/12.6 12.6 SCL

SDA/I2.5 12.5 SDA
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To enable 12C the switches SCL/12.6 & SDA/12.5 must be set to OFF mode. In this mode the
inputs are totally disabled and the 12C is now enabled.

Industrial Shields does not provide any library to implement the 12C as it can be used the
standard library of Arduino called Wire.

10.4 SPI

The M-Duino pins used for the SPI bus are summarized in the table below. For SPI bus MISO,
MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 SO 50
MOSI 518l 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin2/Pin3 | 21/20/1/0/19/18/15/14/2/3

Check the switch configuration at section 8 to enable SS pins.

10.5 TTL

M-Duino has two TTL ports, RX0/TX0, RX1/TX1. TTLO is accessed with the function Serial (pins 0
and 1 of the Arduino Mega). TTL1 is accessed with the function Seriall (pins 18 and 19 of the
Arduino Mega).

In order to use the TTL pins the configuration of the switches have to be the following one:

Switch Analog Shield
ON | OFF

C ZONE
RX1/11.6 11.6 RX1
TX1/11.5 11.5 TX1

If the switches RX1/11.6(11.1) & TX1/11.5(11.0) are in OFF mode, the RX1/TX1 will be enabled. In
order to use TTL3 these switches must be in OFF mode.

10.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the compatible IC compatible
with Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible
with the M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS
Arduino Mega pin 10).
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10.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the 12C protocol.

4 switches have to be configured in order to enable the RTC features:

LEFT ZONE
SWITCH ON OFF RTC SCL & RTC SDA must be set to ON mode to enable
EE - - the 12C wires to the RTC. If they are in OFF mode, the
RTC SCL RTC : Arduino won’t communicate with the RTC.
RTC SDA RTC -
Switch
ON OFF 12C (SCL, SDA pins) must be enabled in order to
SCL/12.6 12.6 SCL communicate with the RTC. See section 11 12C to
SDA/I2.5 12.5 SDA enable it.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC.

10.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switches that configure it. However, there is a switch that
must be placed to ON mode in order to communicate with the uSD:

D53(SD): If this Switch is OFF, it enables the Chip Select of the microSD socket and disables
Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the microSD
can’t be used.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal part and the socket is located
under the supply of the Arduino.

LEFT ZONE
Switch
ON | OFF
uSD
D53(sD) | Q2.0 | D53(sD)
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Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to
select the Chip Select of the uSD chip.

& Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.

& Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est
hors ligne et en sécurité.
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11 Instructions for interconnection between Industrial Shields
controllers

11.1 RS-232 Communication:

-

~ M-Duino 21 /0s “_Another Industrial \'

PLUS ' | Shields PLC |

KRFC-6 Ferrite (4 Loops]
Tx (j‘n T Tx

SHIELDED CABLE

Ferrite KITA Ferrite KITA
GND Ny

XX | by
12124V ‘ @OOO( 12124V
/ ! / '

- \ > & I 1 >

11.2 RS-485 Communication:

11.2.1.1 Half Duplex

. M-Duino 211/0s *_ Another Industrial
' PLUS ' Shields PLC |

KRFC-6 Ferrite (4 Loops)

s [0 I
RS-485 B -.B RS-485
SHIELDED CABLE

Ferrite KITA Ferrite KITA

GND . ' L GND
)I k \
. T C [ ]
11.2.2 Full Duplex
“._ M-Duino 21 1/0s ~ " Another Industrial
PLUS | Shields PLC
A i
RS-485 3 RS-485
z
Ferrite KITA g| ) CAB| E Ferrite KITA
GND . SHIELDED CABLES | [ GND
12124\ )OOC)@ - @OO(X 12124y
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11.3 Ethernet

GND
12124V

KRFC-6 Ferrite

Rev. 2: 12-01-2022

I l

M-Duino 21 I/Os

Ferrite K

PLUS

Ethernet

: Another Industrial '

Shields PLC

Ferrite KITA

GND
P OO Gy

For an Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet

crossover cable must be used.
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12 1/0 technical details:

Digital Output Waveform:

[l o e——
y

DIGITALOUT

DIGITAL OUT

PWM OUTPOUT

leE

4

Pomem—ny

ARDUIND PAWM OUT

CHi= S.@al| |5 5,660 M 1.88ms | CHI % 268GEm.)
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Analog Out Turn On:

]

ANALOGOUT

ANALDG OUT

ARDLINO OUT
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13 Typical Connections

Rev. 2:12-01-2022

(,fmfﬂ ISOLATED INPUT \

&
&

GND
Sharzev

‘] ()10.0

o/,c;jﬁ.ﬁ

SHIELDED CABLE

Ferrite KITA

@l

i

SHIELDED CABLE

/ Dowrdoad e MDUND LAYOUT:
From®

I — S

P — .

Ferrite KITA

1y

— POWER

B oomaw

SHIELDED CABLE .|| Duumlon s MOURO LAVOUT:
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SHIELDED CABLE
2124V o 0.7
GND

Ferrite KITA
0

S wi— I

SHIELDED CABLE ~ /  From wemiierssvohoon \
< ey U

0-10v

— T2, L

Ferrite KITA

GND

L) POWER
2224V B oemauasaocew

SHIELDED CABLE L:":‘:"W \
no—
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SHIELDED CABLE

0-10v

6 51224V
GND
Ferrite KITA
GND
o ®

Ferrite KITA

Rev. 2:12-01-2022

0.7

SHIELDED CABLE Downioed e MOUINO LAYOUT!
i Fromx www.industrisishivids. com \

SR

B owemuour

SHIELDED CABLE

SM2r24v
oA

VOUT = @/ Vde

SHIELDED CABLEf Pty drussentt felipocd \_

ALWAYS
CONNECTED
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SHIELDED CABLE

Ferrite KIT/ ®
GND VOUT = 0/ Vde
m{ﬁ

SHIELDED CABLE

DIGITAL / PWM |SOLATED
OUTPUT

* Sow the swilch
configutarion (ON)
Qivde H- 51224V
COM {-) { GND .&
J ALWAYS
JU1 CONNECTED
Ferrite KITA Q0.8 ® SHIELDED CABLE
f: POWER VOUT = Q/ Vde
"'L; I DIGITALFWA OUT

SHIELDED Cﬁﬂlﬂﬂ L e
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* Soo the switch
configutarion (ON)
Q/Vde
COM (=) gﬁw
Jn CONNECTED
Ferrite KITA 05 @
B Mﬁ] VOUT = Q/ Vide
224V DAGETALPWA OUT
SHIELDED ASL;/—ELT%
\J y
SHIELDED CABLE
—
(/_:uuoeou-rpur )
\I * Analog Outs no led r’f
indlicator
S B * See the switch
1[0 g Olos configutarion (OFF)
M.ii[{;u GND =
@3/0 g O| 02 AO5 E‘—” “'W)
g
ME SHIELDED CABLE
NCiOD O WI!/
Ferrite KITA —ia o
GND
= 9) |} power
20N | 8 ANALOG OUT
SHIELDED CABLE Dowibad o MOMOLAOUT: |
/ e
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14 Connector details:

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MC0,5/10-G-2,5THT

For 1/0 and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference | MC 0,5/10-G-2,5 THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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15 Mechanical Characteristics

- Dimension M-Duino 21 1/0Os PLUS:

0
-
8=
<t
- DIN Rail mounting
Profilato o cappello TH 35-7,5 Prafilato o cappello TH 35-15
Top hat rail TH 35-7,5 Top hat rail TH 35-15
155,
RO8
RO
]
=
+ L_
SRS 1=004
Sezione A/ Section A .
o~ 2,2 min. finoa / To 2,5 max
= -
7l
B Sezione A/ Sedtion A
CARATTERISTICHE METODO  UNIA'  BLEND FEATURES TEST UNITS  BLEND
DIMISURA PU/ABS METHOD PUABS
Mecconiche  Reigoreo o tuzioneolo srenomente  ASTM D638 MPo 68 Mechanical fest Resiionce o tesile stess f yield ASTMDS38 MRy 68
Redisoreo o tuzionea nttw ISTIDB3E  MPo 48 Tonglostength ASTMD638 MR %
Allngomento o totin K088 9 i o ASTMD638 % 9
Mool in fesione STADIN _ MPo 2894 Pleing modules ASTADTS0 MR 7894
Pova Iz0d con intoglio 150180/14 X/ 55 rod test noiched 1018014 X' 55
Termiche Temp di nmmolinento Viat, medoB AT DIS2S  °C 114 Thermal fest Vit sodtening tomperctuee method B ASTMDIS2S 114
Tomperoun Ricto 1 81 My K068 °C 91 Rebeting temperatue 1,81 WPg ASTMD848  °C 9
Fisiche Peso gadfin K092 géamd n Physical test  Spaciic gy ASTHDT®? _ géand 12
Riti nello stompo STADSS % 0408 Mould hiinkage ASTMDSS % 0408
Mol Flow Index 260°C - 98N KSTNDIZE  o/10° 111 Melt Flow Ines 260°C - 98N ASTMDIZ38 10’ 11
Comportamento Avbesinguerza (i di pesoe) [I2) - V-0(08) Flome fest Self atinguishr (thidness in mm) L4 - V0(08)
allo fiomma _Fib Incadescen 37 mm 69521 °C 960 Inndestents thiepd 32 mm IEC89521 960
Italtronic si riserva il diritto di modificare il moteriole con cui realizzo i propri prodotti Italtronic con operate ony change of the materials without being obliged to forewam.
senzo obbligo di preawviso.

For optimal operation of the product, it must be located in an electrical cabinet with IK08
mechanical protection. The minimum IP protection degree required is IP56.
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16 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the I/0 of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino 21 1/Os PLUS from heat, high voltaje and eletrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino 21 1/Os PLUS. When configuring the layout of the M-Duino 21 1/Os PLUS inside
your panel, consider the heat-generating devices and locate the electronic-type devices in
the cooler areas of your cabinet. Reducing the exposure to a high-temperature
environment will extend the operating life of any electronic device. Consider also the
routing of the wiring for the devices in the electric cabinet. Avoid placing low-voltage
signal wires and communications cables in the same tray with AC power wiring and
highenergy, rapidly-switched DC wiring.
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Provide adequate clearance for cooling and wiring M-Duino 21 1/Os PLUS. Is designed for
natural convection cooling. For proper cooling, you must provide a clearance of at least 25
cm above and below the devices. Also, allow at least 25 cm of depth between the front of
the modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25¢cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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17 Revision Table

Revision Number Date Changes
0 30/08/2019 First implementation
1 21/02/2019 ETL Listing Mark-Direct added
2 12/01/2022 Updated CE Normative (2004/108/EC)
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruités de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com

Rev. 2: 12-01-2022

52


mailto:industrialshields@industrialshields.com

